POBedit v0.6 © NoRG. Инструкция пользователя.

Инструкция пользователя POBedit 0.60
1. Редактор каналов

1) Загрузка настроек (списка спутников, транспондеров, каналов) из ресивера.
После запуска программы POBedit Вам будет необходимо загрузить настройки из ресивера или открыть ранее сохраненные.
Для загрузки из ресивера используется команда Receive из меню программы Settings (рис.1)
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Рис.1

Внимание: все подключения и отключения кабелей к ресиверу производить при ОТКЛЮЧЕНОМ от сети 220В ресивере.
Ресивер должен находится в режиме ожидания (Standby). Если у Вас верно выбран компорт (Port) и скорость компорта (Speed) в меню Options→Communication (рис.2.1) то начнется загрузка из ресивера.
Во время загрузки настроек возле меню добавляется шкала загрузки (рис.3) для отображения хода загрузки. Кнопкой Break можно остановить процесс загрузки. На табло ресивера в это время будет отображаться S и остаток процентов выгрузки от 100 до 0. После окончания процесса на табло ресивера высветится donE и ресивер перейдет в режим ожидания (Standby), а в редакторе появится загруженный список настроек.
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Рис.2.1
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Рис.2.2
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Рис.3
2) Загрузка настроек (списка спутников, транспондеров, каналов) в ресивер.
Для загрузки из ресивера используется команда Send из меню программы Settings (рис.1)
Во время загрузки отредактированных настроек в ресивер, также как и при загрузке из ресивера, возле меню добавляется шкала загрузки (рис.3) для отображения хода загрузки. Кнопкой Break можно остановить процесс загрузки. На табло ресивера в это время будет отображаться r и процент загрузки от 0 до 100. После окончания процесса ресивер перейдет в режим ожидания (Standby).
3) Открытие (Open)/Сохранение (Save as…) настроек в компьютере.

Для открытия ранее сохраненных настроек используется команда Open из меню программы Settings (рис.1), а для сохранения отредактированных настроек используется команда Save as… . При использовании этих команд откроется стандартное окно «открыть/сохранить» Windows (рис.4). Формат файлов настроек f3d, что дает возможность редактировать настройки, загруженные другими программами, например openboxf300editor.rc4.
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Рис. 4
4) Основные правила редактирования списка спутников, транспондеров, каналов.

Выделение одного спутника, транспондера, канала:
Щелкнуть мышкой на нужной позиции, при этом выделенная позиция будет помечена зеленым цветом.

Выделение группы спутников, транспондеров, каналов:

Выделение блока - Выделение мышкой группы позиций, а также комбинацией клавиш Shift+(↑/↓) (рис.5.1)
Выделение разбросанных позиций - Выделение мышкой при удерживании клавиши Ctrl или Alt (рис.5.2)
Выделение блока от текущей позиции до начала списка - комбинацией клавиш Shift+Home
Выделение блока от текущей позиции до конца списка - комбинацией клавиш Shift+End
Выделение блока от текущей позиции на 1 экран вверх - комбинацией клавиш Shift+PageUp
Выделение блока от текущей позиции на 1 экран вниз - комбинацией клавиш Shift+PageDown
Выделение всего списка спутников, транспондеров, каналов:
Комбинация клавиш Ctrl+A
Снятие выделения списка спутников, транспондеров, каналов:
Комбинация клавиш Ctrl+D
Перемещение выделенного спутника, транспондера, канала (группы спутников, транспондеров, каналов) вверх/вниз по списку:

Комбинацией клавиш Ctrl+(↑/↓) или Alt+(↑/↓).
Перемещение отмеченных элементов на 50 позиций вверх-вниз с сохранением дистанции элементов:

Комбинацией клавиш Shift+(Ctrl/Alt)+(↑/↓).
Копирование в буфер обмена – Комбинацией клавиш Ctrl+С или Ctrl+Insert
Вставка из буфера обмена - Комбинацией клавиш Ctrl+V или Shift+Insert
Перемещение строки с помощью мышки:
Левой кнопкой мышки щелкнуть на номере строки, и не отпуская клавиши, перетащить в нужную позицию списка (Рис 6.)
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Рис. 5.1
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Рис. 5.2
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Рис. 6
Сортировка отображения списка в окне редактора:

По одному столбцу – щелкнуть мышкой на названии столбца. В результате появится красная стрелка с направлением сортировки (по возрастанию/по убыванию). Для изменения направления сортировки, щелкнуть еще раз на том же столбце.
По группе столбцов – удерживая клавишу Shift, щелкнуть мышкой на заголовке нужных столбцов, при этом в красной стрелке будет отображаться номер приоритета сортировки, а именно над первым сортируемым столбце будет отображаться 1, над вторым 2 и т.д. (рис.7)
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Рис. 7

Примечание: Название окна выделяется красным если оно активно, например на рис.8 активным является окно Sattelites, а не активным окно Transponders.
Внимание: после заливки изменений в ресивер, все перемещения будут сохранены в ресивере, кроме изменений порядка в списке спутников.

5) Использование панели поиска.

Включение/выключение панели поиска производится из меню View - Search Paneles или комбинацией клавиш Ctrl+F. Панель будет находится в неактивном состоянии до тех пор, пока в строке поиска не введется какое-либо значения для поиска. После ввода значения, по нажатию на кнопку Next произведется прокрутка экрана активного окна до первой нужной позиции, совпадающей введенному значению в строку поиска. Кнопкой Highligt производится «подсветка» синим цветом найденного совпадения. Для упрощения пользования поиском можно пользоваться функцией копирования/вставки (Ctrl+C)/(Ctrl+V) (рис.8)
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Рис. 8
6) Список спутников.

Вкладка Transport, окно Sattelites.
Все операции производятся над выделенными спутниками (подсвеченные зеленым строки в списке). После выделения стает активной строка изменения параметров (рис.9). Имеется возможность изменить следующие параметры:
· Название спутника ([image: image11.emf]

) – вводится вручную или вставкой (Ctrl+V), максимальное количество символов – 16. Сохранение изменений производится клавишей Enter.
· Расположение спутника на орбите ([image: image12.emf]

) – любое цифровое значение формата ###,# Сохранение изменений производится клавишей Enter.
· Выбор переключателя ([image: image13.emf]

) – выбор из списка необходимого значения. Сохраняется немедленно.
· Выбор порта DiSeqC 1.0 ([image: image14.emf]

) – становится активным после выбора соответствующего значения Link. выбор из списка необходимого значения. Сохраняется немедленно.
· Выбор порта DiSeqC 1.1 ([image: image15.emf]

) - становится активным после выбора соответствующего значения Link. выбор из списка необходимого значения. Сохраняется немедленно.
· Установка частоты конвертора LNB ([image: image16.emf]

) - вводится вручную или вставкой (Ctrl+V), только цифровые символы. Сохранение изменений производится клавишей Enter.
· E/W - Расположение спутника на орбите (восток/запад). Выбор значения щелчком мыши, сохранение немедленное.
· Включение/выключение питания конвертора LNB ([image: image17.emf]

)- Выбор значения щелчком мыши, сохранение немедленное.
· Включение/выключение 12В ([image: image18.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Установка тонового сигнала ([image: image19.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· ([image: image20.emf]

) – удаление всех транспондеров и каналов данного спутника.
· Добавление нового транспондера ([image: image21.emf]

) – Выполнение щелчком мыши. В результате действия данной команды для данного спутника внизу списка транспондеров добавится новый с нулевыми значениями, которые необходимо будет ввести.
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Рис. 9
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Рис. 10
Те же изменения доступны и из контекстного меню (рис.10) , которое вызывается нажатием на списке спутников правой кнопкой мыши.
7) Список транспондеров.
Вкладка Transport, окно Transponders.
Все операции производятся над выделенными транспондерами (подсвеченные зеленым строки в списке). После выделения стает активной строка изменения параметров (рис.11). Имеется возможность изменить следующие параметры:
· Поляризация (V/H) – Выбор значения щелчком мыши, сохранение немедленное.
· Частота ([image: image24.emf]

) - любое цифровое значение формата #####. Сохранение изменений производится клавишей Enter.
· Скорость потока (Symbol Rate) ([image: image25.emf]

) - любое цифровое значение формата #####, четырех- или пятизначное число. Сохранение изменений производится клавишей Enter.
· ([image: image26.emf]

) - выбор из списка необходимого значения. Сохраняется немедленно.
· Удаление из списка выделенного транспондера ([image: image27.emf]

) – Выполнение щелчком мыши. Возвращение транспондера в список не возможно!
· Добавление нового теле- или радиоканала ([image: image28.emf]

) - Выполнение щелчком мыши. В результате действия данной команды в низу списка каналов добавится новый канал для данного транспондера с именем NEW *** CHANNEL и с нулевыми значениями SID, PMT и Track, которые необходимо будет ввести вручную.
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Рис.11
Те же изменения доступны и из контекстного меню (рис.12) , которое вызывается нажатием на списке транспондеров правой кнопкой мыши.
[image: image30.jpg]H
FRQ 3758

ElEooo]

FEC ALTO

b add chammel

9 Delete ol




Рис.12
8) Список теле-, радиоканалов.
Вкладка TV Channels (Radio Channels), окно Channels.
Все операции производятся над выделенными каналами (подсвеченные зеленым строки в списке). После выделения стает активной строка изменения параметров (рис.13). Имеется возможность изменить следующие параметры:
· Название канала ([image: image31.emf]

) – вводится вручную или вставкой (Ctrl+V), максимальное количество символов – 16. Сохранение изменений производится клавишей Enter. Для сохранение названия в ресивере рекомендуется отключить в меню ресивера обновление имен каналов (Настройка системы - Другие настройки - Обновление имен каналов - ВЫКЛ).
· (SID) [image: image32.emf]

 - вводится вручную или вставкой (Ctrl+V), любое цифровое значение формата #####. Сохранение изменений производится клавишей Enter.
· (PMT) [image: image33.emf]

 - вводится вручную или вставкой (Ctrl+V), любое цифровое значение формата #####. Сохранение изменений производится клавишей Enter.
· Кодированный/не кодированный ([image: image34.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Блокированный/не блокированный ([image: image35.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Номер аудиодорожки ([image: image36.emf]

) - выбор из списка необходимого значения. Сохраняется немедленно.
· Auto or Manual ([image: image37.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Параметры звука (Стерео, левый, правый) ([image: image38.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Параметры громкости звука ([image: image39.emf]

) - Выбор значения щелчком мыши, сохранение немедленное.
· Изменение принадлежности канала к телевизионному или радио ([image: image40.emf]

) - Выбор значения щелчком мыши, сохранение немедленное. В результате действия канал переместится в другой список каналов (из TV Channels в Radio Channels или наоборот) с сохранением всех параметров.
· Добавление в активный «любимый» список каналов ([image: image41.emf]

) – Выполнение щелчком мыши, сохранение немедленное. Добавление только в текщий выбранный «любимый» список каналов. Пункт меню становится активным только после выбора одного из «любимых» списков (читай главу 1.9).
· Добавление в любой из «любимых» списков каналов ([image: image42.emf]

) – Выполнение щелчком мыши, сохранение немедленное. Добавление в любой из 12 «любимых» списков каналов.
· Удаление канала ([image: image43.emf]

) – Выполнение щелчком мыши. Удаление каналов происходит из основного списка и из всех «любимых», куда они был занесены. Возвращение каналов в список не возможно!
· Удаление всех каналов, которые не внесены в «фавориты» ([image: image44.emf]

) – Выполнение щелчком мыши только из контекстного меню. Удаление каналов происходит из основного списка. В списке остаются только те каналы, которые внесены в любой из «любимых» списков. Возвращение каналов в список невозможно!
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Рис.13

Те же изменения доступны и из контекстного меню (рис.14) , которое вызывается нажатием на списке каналов правой кнопкой мыши.
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Рис.14

9) «Любимые» списки теле-, радиоканалов.
Вкладка TV Channels (Radio Channels), окно Favorites.
Выбор «любимого» списка каналов производится из контекстного меню редактирования параметров канала (рис.14) или в дополнительном пункте меню TV Favorites/Radio Favorites (рис.15). Выбор необходимого «фаворита» производится мышкой из выпадающего списка.

Из «любимого» списка доступны почти все изменения над каналом, что и из основного списка каналов. Отличия:

· нельзя измененить принадлежности канала к телевизионному или радио ([image: image47.emf]

).
· удаление канала происходит только из «любимого» списка, в основном списке он остается.

· ([image: image48.emf]

) – копирование канала в другой «любимый» список.
· ([image: image49.emf]

) – перемещение канала из текущего списка в другой «любимый» список.
Изменение имени «любимого» списка производится в окне пункта меню TV Favorites/Radio Favorites (рис.15) или из контекстного меню (рис.14) прямо в поле названия списка. После ввода необходимого названия, для его сохранения нужно нажать Enter.
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Рис.15
2. Редактор ключей.
10) Загрузка ключей из ресивера (в ресивер), Открытие (Open)/ Сохранение (Save as…) файла ключей в компьютере.

Для загрузки из ресивера используется команда Receive из меню программы Keys, а для сохранения - команда Send (рис.16).
Все остальные действия аналогичны загрузки(выгрузки) настроек (описание в главах 1.1, 1.2 и 1.3.)
Если вы все действия выполнили верно, то во вкладке Keys появится загруженный список блоков ключей.
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Рис.16

11) Редактирование ключей.
Для начала редактирования блока ключей необходимо в списке выделить необходимую позицию (изменения возможно сделать только над одной позицией, над группой невозможно). С помощью панели изменения параметров ключей (рис.17) можно будет изменить следующие значения:
· Добавление нового блока ключей ([image: image52.emf]

) – Выбор из списка необходимого значения. Сохраняется немедленно. Возможные варианты блоков: Sharing, Seca, Viaccess, Irdeto, Conax, Cryptowork, Nagravision, Biss. После выбора необходимого значения, новый блок добавляется в конце списка блоков (окно Blocks). Для изменения нового блока необходимо его выделить щелчком мыши. Максимальное количество блоков – 128. При достижении этого количества кнопка стает не активной. Также имеется ограничение в 4 блока (32 ключа) для ключей Biss, все последующие будут ресивером просто игнорироваться.

· Удаление блока ([image: image53.emf]

) - Выполнение щелчком мыши, сохранение немедленное. Удаленный блок восстановить не возможно!
· Идентификатор провайдера ([image: image54.emf]

) - Вводится вручную или вставкой (Shift+Ins), максимальное количество символов – 6. Сохранение изменений производится клавишей Enter.
· Ключ ([image: image55.emf]

) - Вводится вручную или вставкой (Shift+Ins), (первая пара это номер ключа, остальные 8 пар – сам ключ). Исключение: ключ в блоке BISS состоит из 12 символов (6 пар), и для его активации нужно поставить галочку перед ключом в окне Keys (рис.18). Сохранение изменений производится клавишей Enter.
· (SA/UA/PPUA/CHID) - Вводится вручную или вставкой (Shift+Ins). Сохранение изменений производится клавишей Enter. Данный параметр появляется только в определенных случаях, которые зависят от системы кодирования и провайдера.
· Очистка ключа ([image: image56.emf]

) - Выполнение щелчком мыши. Восстановление не возможно.
· [image: image57.emf]

 - Копирование ключа в буфер обмена.

· [image: image58.emf]

 - Вставка ключа из буфера обмена.

Примечание: в поля ID, Key и SA/UA/PPUA/CHID можно ввести только цифры от 0 до 9, и буквы от A до F (неважно, большими или маленькими). Пробелы между парами можно не вводить, так как при сохранении они все равно удалятся.
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Рис.17
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Рис.18
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                                       Рис.19                                                       Рис.20
Те же изменения над доступны и из контекстных меню (рис.19, (рис.20) которые вызываются нажатием правой кнопкой мыши.

3. Дополнительные возможности программы.

12) Экспорт настроек в формат HTML.

Выполняется с помощью команды Settings→Export HTML  (рис.1). В выбранном Вами каталоге на жестком диске будет создано 4 файла: Имя файла.SAT.htm (содержит список спутников), Имя файла.TRS.htm (содержит список транспондеров), Имя файла.TVR.htm (содержит список телеканалов), Имя файла.RAD.htm (содержит список радиоканалов). Имя файла – имя, которое Вы ввели при сохранении. Имеется возможность выбора сохраняемых списков в меню Options-Export (рис.2), где нужно отметить желаемые списки, а также возможность их немедленного просмотра после экспорта.
13) Перемещение панели редактирования параметров (Properties).

Имеется возможность разместить панель редактирования параметров в удобном для вас месте. Для этого нужно на пустом месте или на заголовке этой панели щелкнуть левой кнопкой мыши, и когда курсор примет вид [image: image63.emf]

 не отпуская кнопку, переместить панель в нужное Вам место, например в низ окна программы (рис.21). В «открепленном» виде панель можно увидеть на рис. 22.
14) Меню программы View

С помощью этого меню (рис.23) можно выполнить следующие действия:

· Search Panels ([image: image64.emf]

) – скрытие или отображение панели поиска.
· AutoSize Columns ([image: image65.emf]

) – авторазмер колонок под содержимое. Размер колонок также можна изменять и вручную с помощью мышки.

· Renumber Table ([image: image66.emf]

) – принудительная перенумерация строк в текущем списке после того, как была произведена некая сортировка или удаление из списка.
· Reset to Defaults ([image: image67.emf]

) – возврат настроек отображения к настройкам «по умолчанию».

[image: image68.jpg]M1 INTERN-L

105 1,2/Ku

10764]

112

ELROPE 2 TY

HOTBIRDJK

27500)

150

21 H 20000 6| $| | fmefst| |z H| 12245] 110

28nEws 24 awostziu W 1064 26000| 6| s217|§| | 1[no| st | | 2slawmusic HoterRoKu || 12360 27500 14mia| 418

29 TRK SVIT avostziu |H| wo7ee 26000 6| 1aa|s| | 1fmo| st | || 28|rmeer exeress avziku | v | 11044| 23800 1] 34
30/Money Channel  |avos 120y || 10%2s| 27s0n| 125| 293[s | | 1|west | | solweoty exeress avzziku | v | 11044| 29800 2| 37

31 vinimax amostziu  |H| 10925 27so0| 127 2ss§| | afmo| st | || ‘3a|muerviovery |eeress amzziu [v | 1104s| 2sen0| 5| s
S2\vinimaxRomfas |avos 12y |H| 11ze| zzs0n| 1| zes|s| | 1fwo| st | || s2leumusic pavamsar i |v| 12518] s232| 1] e

¢ | %) JI J Low Jlo J |

Neme ENTER | S0 ess0 | PHT 6530 £ # | Track 1= A Mode stereo = Vokime Normal





Рис.21
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Рис.22
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Рис.23

4. SoftCam Editor

15) Запуск редактора Softcam

Запуск редактора Softcam производится из меню Keys→Import SoftCam (рис.24)
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Рис.24.
Из меню SoftCam Editor вы можете выполнить следующие действия:
· File→Open…([image: image72.emf]

) - открытие (загрузка) SoftCam (файла с ключами). Обычно расширение такого файл key, например SoftCam.Key, Emukeys.key, Biss.Key и т.д., кому какой нужен, но вы можете выбрать любой.

· File→Save as…([image: image73.emf]

) - сохранение отредактированного SoftCam в формате: key, rtf, html
· Compile→Check ([image: image74.emf]

)– проверка SoftCam на соответствие с форматом ключей ресивера. При выполнении компиляции в информационном окошке снизу могут появляться сообщения об ошибках (Error) или предупреждения (Warning). Критичными являются только Error, так как при их наличии невозможно выполнить обновление ключей. При Warning обновление ключа не произведется только из той строчки, что вызвала данное предупреждение. Настроить редактор можно из меню Options→Softcam compiler (рис.26).

·  Threat Errors as Warnings – игнорирование Error и Warning при компиляции.
· AutoClose after Update – автоматическое закрытие окна SoftCam Editor при выполнении команды Update keys.
·  AutoLoad Last Keys File - автозагрузка последнего открытого файла с ключами.

·  AutoOpen when Empty – автоматический запрос на открытие файла, если редактор пуст.
· Compile→Update keys ([image: image75.emf]

) – добавление и обновление ключей из SoftCam в файл ключей ресивера f3k. Эта функция становится активной только после безошибочной компиляции SoftCam (отсутствие Error) или включенной опцией Threat Errors as Warnings в меню Options→Softcam compiler.
· TPS Update ([image: image76.emf]

) – Запуск плагина. Описание в п.19.
· File→Exit ([image: image77.emf]

)– выход из SoftCam Editor.
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Рис.25
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Рис.26
16) Основные правила работы с редактором SoftCam
Если при выполнении компиляции в информационном окошке снизу появились сообщения об ошибках (Error) или предупреждения (Warning), то Вам необходимо будет отредактировать загруженный SoftCam. Для быстрого обнаружения ошибки нужно дважды щелкнуть мышкой на сообщении в нижнем окошке, и автоматически строка с ошибкой выделится красным цветом в окне с SoftCam (рис.27). При редактировании вы можете использовать все стандартные функции перемещения по тексту, вставки/копирования, удаления и т.д., как и у стандартных редакторов текста.
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Рис.27
17) Синтаксис «правильного» SoftCam

Строчка с ключом должна быть вида:
S 0065 0E D02F36F0C5B42F23 ;CYFRA 13°E key update: 24/04/2004
где:

первый символ в строке, в данном примере S, принадлежность к кодировке.
I 
– Irdeto
S 
– Seca
V 
– Viaccess
N 
– Nagravision
W 
– Cryptworks
B(F)
– Biss
X
– Conax
В некоторых типах файлов с ключами иногда встречаются другие символы. В этом случае Вам будет необходимо изменить в начале строчки символ данной кодировки на принятую в редакторе, иначе строка определится как комментарий. В точке, где произошла ошибка разбора строки, начинается комментарий:

; ORF (19,2E)

IZ 00 02 A2809E50D9204E21 ;

I 00 : 04 07011564B93CB04C ;

I 10 XI 04 07011564B93CB04C ;

I 00 05 XddB9DC19BBD68A5C32 ;

I 00 06 AFFFOf5191ACE66AC1A ;
Далее через минимум один пробел идет идент провайдера (0065), еще минимум через один пробел номер ключа (0E), а далее сам ключ (D02F36F0C5B42F23). Между всеми значениями должен стоять минимум один пробел. Количество знаков в иденте провайдера, номере ключа и в ключе должно строго соответствовать, иначе строка будет опознана с ошибкой (Error). В иденте, номере и ключе допустимы только символы из ряда 0…9, A,B,C,D,E,F. Двоеточие (":") в софткам считается как пробел.
Правила оформления ключа:

Cryptworks, Viaccess, Irdeto – принадлежность к кодировке, 3 байта провайдер, номер ключа, 8/16 ключ.
Nagravision, Conax, Seca - принадлежность к кодировке, 2 байта провайдер, номер ключа, 8/16 ключ.

Biss - принадлежность к кодировке, 8/6 ключ.
Примечание: Включена отдельная обработка ключей на TPS AES. Хотя ключи публикуются в формате 007с00, вводить их надо в 7с0000. Теперь этот случай проверяется отдельно.
18) Обновление ключей (Update keys) из SoftCam в файл ключей ресивера f3k.

После правильной компиляции SoftCam (количество Error = 0 или в случае с включенной опцией Threat Errors as Warnings в меню Options→Softcam compiler) становится активным пункт меню Update keys. При выполнении этой команды произведется добавление ключей из файла SoftCam в загруженный раннее Вами файл с ключами из ресивера. При компиляции ключи проверяются на наличие в текущем файле ключей, и при совпадении не добавляются в конечный файл. Добавлены будут только новые провайдеры и новые ключи. Компилятор понимает ключи 8/16 байт (16 разбивает на 2), для BISS - 8/6 (в 8 выкидывает 4 и 8 байт).
19) Обновление ключей TPS из Интернета (TPS Update) и добавление его в файл ключей ресивера f3k.

Перед выполнение этой операции рекомендуется сначала загрузить из ресивера все ключи или открыть для редактирования ранее сохраненный файл f3k, иначе если этого не сделать то после заливки ключей TPS в ресивер вы в ЕМУ ресивера не обнаружите ни одного ключа, кроме TPS.


Загрузка ключей производится из меню командой TPS Update. В результате в редактор будет загружен свежий ключ с сайта, который прописан в плагине getkeys.dll (в версии 0.60 этот сайт http://rubydesign.info/aes/linuxkeys.php). Вы можете самостоятельно изменять плагин, для этого нужно в файле getkeys.dpr, который поставляется с программой, изменить указанные ниже строчки под свои требования и скомпилировать его в Delphi в файл getkeys.dll.
S := POBE_GetHTTP('http://rubydesign.info/aes/linuxkeys.php', 5000);

Key := 'V 007C00 00 ' + Copy(S, 27, 16) + Copy(S, 44, 16); - эта строка подгоняет формат ключа с страницы загрузки под формат редактора софткама.

Примечание: Файлы getkeys.dpr и getkeys.dll ищите в архиве с программой.

Имеется также возможность вызывать плагин по таймеру (Рис.27). Для этого выставьте в его подменю интервал запуска (Run every), включите "Run continuously", включите AutoSend after Update для автообновления и нажмите на кнопку плагина TPS Update.
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Рис.27
В этом же подменю в случаи использовании Вами Proxy нужно выставить необходимые параметры, такие как порт, логин, пароль. 
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